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Abstract

JAGUAR (JAva GUi for Applied Research) is a Java software tool providing an advanced
text editor and graphical user interface (GUI) to manipulate DAKOTA (Design Analysis
Kit for Optimization and Terascale Applications) input specifications. This document
focuses on the features necessary for a user to use JAGUAR.
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1: Introduction

JAGUAR (JAva GUi for Applied Research) is a Java software tool for automatically rendering a
graphical user interface (GUI) from a structured input specification. The dynamically-generated
interface enables users to create, edit, and externally execute analysis application input files and
then view the results. JAGUAR is built on top of the Eclipse Framework as an Eclipse Rich Client
(http://wiki.eclipse.org/Rich Client Platform/FAQ) product, providing it the look, feel, and
features of Eclipse Applications.

JAGUAR serves as a GUI for DAKOTA (Design Analysis Kit for Optimization and Terascale
Applications). It parses a DAKOTA NIDR (New Input Deck Reader) input specification and
presents the user with linked graphical and plain text representations of problem set-up and
option specification for DAKOTA studies. After the data have been input by the user, JAGUAR
generates one or more input files for DAKOTA; it can also execute DAKOTA, capturing and
(eventually) interpreting the results.

JAGUAR 2.1 is available for Windows 32- and 64-bit platforms, Mac (Intel processors), and Linux
32- and 64-bit platforms. While JAGUAR's core source is BSD licensed, binary distributions of
JAGUAR include Eclipse Workbench components and are therefore subject to the terms of the
Eclipse Public License.






2: Downloading and Installing JAGUAR

A short description of the steps for downloading and installing JAGUAR is provided here;

however the most current information can usually be found on the download pages.

Install supporting JAVA software (if needed). JAGUAR requires a Java Runtime
Environment (JRE) version 5.0 or above. (Sun has revised its 1.X.X versioning system, and
version 5.0 is the same as 1.5.0 in the old numbering scheme.) If a Java Runtime
Environment is not already installed on your machine, you will need to download and
install a 5.0 JRE from: http://java.sun.com/j2se/1.5.0/download. jsp
(click on “Java Runtime Environment (JRE) 5.0 ...”)

Download JAGUAR. JAGUAR is available from the DAKOTA website
http://dakota.sandia.gov/download.html. Select Registration Form under
External Downloads and complete the short online registration form to be redirected to
the download page, which you may then bookmark directly. Download the JAGUAR
package for your platform (Windows 32/64-bit, Mac, or Linux 32/64-bit).

ATTENTION: for proper operation you should match the JAGUAR and JRE architectures.
For example, 32-bit JAGUAR should be used with a 32-bit JRE, similar for 64-bit JAGUAR
with 64-bit JRE. We recommend also matching the operating system architecture, but
have had success with, e.g., running 32-bit JAGUAR and JRE on 64-bit Linux.

Install JAGUAR.

1. Windows users: We provide an installer that will automatically install
JAGUAR. Double-click the installer to start installing and follow the
instructions. After installation, JAGUAR can be found in the Start menu, your
desktop, or at the installed folder.

2. Mac users: We provide a dmg (Mac OSX disk image) installer for quick
installation. Double-click the installer and the installer will be mounted
automatically. Drag the Jaguar folder into the Applications shortcut folder.
JAGUAR can now be found under Applications.

3. Other users & manual installation: We provide the JAGUAR package as a
zipped archive file. Windows and Mac users should be able to double-click on
the file’s icon from a file system browser to perform the extraction. Linux
users can use the unzip utility to unzip the archive from their command-line
console. The JAGUAR installation package is self-contained, so JAGUAR can be
directly run immediately after extracting the archive. (See Figure 1). Take note



of where you installed as you may want to create a shortcut or link to the
installed JAGUAR executable.

e Important! If you have a previous version of JAGUAR installed it is recommended to
move your personal JAGUAR workspace directory to a different location or remove it
(this directory can be found in your home directory or User_folder >Jaguar_workspace)
to prevent corruption of the workspace when running JAGUAR 2.1.

MNarne Date modified Type Size

configuration 12/17/2010 2,59 Pha - File folder

dakreorder 12/17/2010 3:59 PhA File folder

features 1173042010 439 Ph4 File folder

install 1271742010 259 Ph4 File folder

plugins 121772010 359 PR File falder
|| eclipseproduct 12/17/2010 359 Pk ECLIPSEPRODUCT... 1KE
|| COPYRIGHT 12/17/2010 350 PR4 - File 1KE
B Jaguar.exe 12/17/2010 259 PR Application 52 KB
£ | Jaguar.ini 1271742010 359 PRt Caonfiguration sett.., 1KE
|| LICEMSE 12/17/2010 359 PR File 2KB
|| README 12/17/2010 350 PRA - File KB

Figure 1: File listing for JAGUAR installation package



3: Running JAGUAR for the First Time

When starting JAGUAR for the first time, you should see a “Welcome” screen. As shown in
Figure 2, the Welcome screen provides quick navigation to many JAGUAR features. This screen
can be closed at any time by clicking on the “X” located on the Welcome tab and returned to at
anytime via the JAGUAR help menu (Help - Welcome). The welcome screen always appears in
front of, i.e., it hides the entirety of the user interface and must be dismissed to use the
principal GUI.

To note, there is a checkbox option at the bottom to toggle showing the welcome screen at
startup. There are also navigation buttons in the top right corner to navigate between
Welcome screen content pages (Figure 2). Welcome options include the following.
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JAGUAR s built on the Eckipse Workbench Before starting, use these guides 10 otient yourself irst to key Eclpse feanures
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Common JAGUARDAKOTA tasks
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Figure 2: JAGUAR Welcome screen

¢ Start JAGUAR. This closes the Welcome screen and proceeds to the regular JAGUAR view.

. Configure JAGUAR. JAGUAR preferences are set here (See Figure 3). It is advised to set
the DAKOTA executable path at a minimum. You may also optionally specify the save and
template paths. Lastly, there are preference settings affecting toolbars described in Chapter 5:
Graphical Editors.

Note: Mac/Linux users may notice a setting to prepend the DAKOTA bin directory to their
execution & library paths. This is typically necessary for DAKOTA to run correctly
without affecting your global environment.



aNOo Preferences

type filter text Jaguar A ot
¥ General
Jaguar DAKOTA executable  /Users/echan/Downloads/Dakota 2/bin/dakota { Browse... |

I [ﬂ Prepend DAKOTA bin directory to execution and library path I

| Save path fUsers/echan/Documents (" Browse.. ) |
Templates path fUsers/echan (" Browse.. )

E Display pretty names by default
[] See comments by default
E See help by default

M Push up one level of child elements

| { Restore Defaults ) [ Apply

| 5 !

] @ ( canct ) OK ) |
|
|

2

Figure 3: Preferences for file locations and user interface behavior

e Tours. The Tours section offers guides for beginning users. As JAGUAR is built on the
Eclipse Workbench, new users will benefit from the Eclipse Workbench Tour, a quick
online reference for Eclipse framework features like Views, Perspectives, etc. The
following two tours are the Guided Tours, which are presented in the form of Cheat
Sheets (See Figure 4).

I Jaguar - DART Workspace/Usersfechan/Documents/DAKOTA templates/Rasenbrock_Fived.dak - Jaguar EI@
File  Edit ‘Window Help
W;l Rosenbrock_Fixed.dak &2 = 59|(B Cheat Sheets 32 H - =5
0 - .

1 DAEOTL INFUT FILE - dakot nh k Zd.d - - -

: Efmegy CEEe ECEERlEE Bdan Creating a DAKOTA

3 single_method Parameter Study

4 graphics ~ Introduction

5 tabular_graphics_data Inth et 0 .

& thod n this guided tour, we'll create a

= metho 1ria © tud DAKOTA parameter study from

MULL L _PArameter Study scratch, This example is based on the

8 partitions 8 8 multi-dirmensional parameter study in

5% model Chapter 2 of the DAKOTA User's

1o single Manual (http:fiwww.cssandia.gov

11~ rariahles dakotajdocumentation/)

1z continuous design 2

13 lnmer_}:nunds _2 _2 Botypical simple DAKOTA input

specification consists of a rmodel,

2 upper_bounds 2 2 which rnaps variables through an
15 deseriptors 'x1' fx2! interface (user application) to
1= interface responses, and an iterative method,
17 analysis_drivers 'rosenbrock! which will repeatedly evaluate the
13 direct model,
19 responses
20 num chiective functions 1 Before starting, consider setting a
21 no Eradlents - \ofation of a DAKOTA executable in
- Window » Preferences » Jaguar,
22 no_ hessians
23 - & Click ta Begin
b Create a DAKOTA input file
b Motice
» Define Problem
¥ Define FlowTteration
i b Ohserse
— - b Execute Problem
Source Define Problem Define FlowTteration Execute Problem Wisualize Results : \:‘:Ltllze ezt -
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Figure 4: A sample JAGUAR cheatsheet.

JAGUAR Cheat Sheets are a useful mechanism for quickly learning how to perform
important JAGUAR operations such as opening and saving files. They utilize an interactive
step-by-step approach to guide new users through JAGUAR. Cheat Sheets usually dock
on the side of the application so as to not obstruct user interactions, and can always be
accessed from the JAGUAR help menu (Help = Cheat Sheets).

e Common Tasks

e Create new input file. This link creates an empty DAKOTA input file. New input files
can also be created by selecting New -» DAKOTA input file from the File menu.
Users must enter a file name for newly-created input files when saving them for the
first time.

e Create new input file from template. This links creates a new input file from existing
DAKOTA templates. Users must also enter a file name when saving these
newly-created input files. This action can also be accessed from the File menu by
selecting New -> DAKOTA input file from template.

Sensitivity Analysis Wizard. See “Chapter

11



e 7:Sensitivity Analysis Wizard”

e Getting Help. The remaining links are used for DAKOTA references, sending an email to
the JAGUAR developers, and viewing existing JAGUAR bugs.

4: Text Editors

Figure 5 shows an example DAKOTA input file in the JAGUAR text editor. The text editor
interface is the first of two primary interfaces that JAGUAR contains for creating and modifying
DAKOTA input files. For text-based editing, the “Source” tab toward the bottom of the JAGUAR
window reveals the raw DAKOTA input file text (likely only comfortable for experienced DAKOTA
users). Refer to the DAKOTA User’s Manual Section 2.3 “DAKOTA Input File Format” for a better
understanding of how input files are structured.

3 laguar - DART _Fied.dak - Jagusr = o |
Fibe [dt Window Help

198 “Rasenbrock_Fised.dak £1

strategy
hics

Source Defne Problem Define FlowiTteration Execute Problern Wisualize Results

Figure 5: JAGUAR text editor

The JAGUAR 2.1 text editor supports:

e Advanced syntax highlighting of errors and warnings with the ability to mouse over
keywords for additional details.

¢ Auto-completion of keywords using Ctrl-Space.

¢ Text formatting

JAGUAR 2.1 introduces highlighting keyword errors and warnings (See Figure 6). Keywords
with warnings (i.e. invalid values) are decorated with yellow squiggly lines (and a yellow warning

12



icon on the left). Keywords that are not recognized are decorated with red squiggly lines (and
ared erroricon on the left). For additional information, mouse over either the squiggly lines or

icons.

optimization type
gpelling mistake

N T T

iy
81

Figure 6: Warnings and errors in the text editor

JAGUAR automatically color codes main keywords in purple, regular keywords in blue,
comments in yellow, string values in green and the rest (including values and unrecognized
keywords) in black. Additionally, when the cursor is over any keyword, a tooltip with relevant
information is shown (see Figure 7).

= method
vector parameter study
final point 1.1 1.3

U St method * : no value
109 model vector parameter study * i no value
single final_point (Termination point of vector) * @ Array of reals

3 L 0o

“'variables

[}
[ WU % I P

continuous | http:/ fwwow . cs.sandia.gov/daketa/licensingvotd /html-ref/Method Cormmands. htm FMeth od PSVPS

1 initial

Mo subelements
=

15 descrip

Figure 7: Keyword tooltip example

Autocomplete is triggered by pressing Ctrl-Space to show suggestions and then double-clicking
to select the desired keyword. However, there are two modes to be aware of:

1) Autocomplete an incomplete keyword (See Figure 8): valid keyword completions are
suggested.
2) Autocomplete from scratch (Figure 9): all keywords valid at the current position will be

suggested.

e

stratl

.-.-.Irn

Lﬁ strategy

Figure 8: Autocompleting an existing keyword
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Figure 9: Autocompleting from scratch

Let’s look into the suggestions. There are times when many valid keyword suggestions will be
possible, potentially at different ‘levels’. For example in Figure 10, we see all the available
keywords available for autocompletion after the keyword optimization_type:

“method
dot_bfgs
optimization type

~7  maximize (a required option) - optimization_type
minirmize (a required option)

os] linear_inequality_constraint_matrix
|L_5|Iir'|ear_inequality_lnwer_bounds
[o5] linear_inequality_upper_bounds
[A] linear_inequality_scale_types
[o5] linear_inequality_scales
[os] linear_equality_constraint_matrix
@Iinear_equality_targets
iEIinear_equality_scale_types
[05] linear equality scales
Alid_method
Emodel_pninter

output
[1] max_jterations

[1] max_function_evaluations

speculative

[o5] convergence tolerance

@constraint_tolerance
scaling
ﬂfinal_solutions
strategy
method

variables

interface

FEZQONSE:

Figure 10: Keywords valid at different levels
Four groups of suggestions are presented in order of decreasing locality. Let’s take a closer look:
1. First group (optimization_type in trailing gray)

The first thing to notice is the trailing keyword in italicized grey (‘optimization_type’)

which indicates the originator or parent, and is also highlighted in the text prior. The
14



asterisk on the left indicates one of these required options should be selected (but
currently none is selected).

2. Second group (dot_bfgs in trailing gray)

These are keywords that are valid and derived from optimization_type’s originator,
dot_bfgs. Notice the type icons on the left, e.g., ‘1’, ‘0.5’, and ‘A’, indicating that
integer, real, and string values respectively are valid.

3. Third group (method in trailing gray)

These are keywords that are valid directly in a method specification. Notice some have
no type icons, representing keywords that do not require an associated value. The
keyword output has a green dot icon, representing it has derived (child) keywords.

Since method is a top-level section keyword, all remaining section options appear in the
fourth group.

4. Fourth group (section)

These are the top-level DAKOTA input sections (strategy, method, variables, interface,
responses) that are applicable at the current context. Since main sections can be
inserted anywhere, these are usually available for autocompletion, though DAKOTA
syntax may restrict the number of them that can be created.

JAGUAR allows automatic formatting of the text using Edit = Format or Ctrl-Shift-F (See Figure
11). JAGUAR will auto-indent the keywords and clean up the specification. For example,
double quotes are replaced with single quotes, extra spaces are removed, and keywords are
sorted in the order defined by the DAKOTA grammar.

15



1= strategy 1= strategy

2 single method 2 single_method
3 graphics 3 graphics
4 tabular graphics data 4 tabular graphics_data
S- method - - 57 method
& dot bfogs & dot_bfgs
7= model T= model
8 s=ingle 2 singls
9% variables § o variables
10 continuous_design 2 g continuocus design 2
11 initial point -1.2 1 L inivial peint -1.2 1
| T . - 12 descriptors 'xl1' "x2"
12 descriptors 'xl' Tra"
13 lower bounds -2 0.001

13 lower bounds -2 0.001 . - - -

- - ~ ~ 14 upper bounds 2 2
j REE=SEbenndSgED ; : < 15 scale types 'val'.lla' 'log'
15 =cale types 'value' 'log’ 16 scale; 4 0.1
le scale= 4 0.1 179 interface
1r= interface 18 analysis drivers 'rosenbrock'
g8 direct analysis drivers ‘rosenbrock' 19 direct
19- responses 20° responses
20 objective function scales 50 =2al num objective functions 1
21 num objective functions 1 22 objective function scales 50
22 objective function scale types 'wvalues' 23 objective:f-_mction:.scale_types 'value'
23 analytic gradients 24 analytic_gradients
24 no hessians 25 no _hessians

Figure 11: Effect of automatic text formatting

Top-level specification section blocks can be compressed/uncompressed as seen in Figure 12 by
clicking the -/+ buttons to the left of a section title.

g7 variables

10 continuous_design 2
11 initial point -1.2 1

12 descriptors '®1' ®x2!

13 lower bounds -2 0.001

14 upper_bounds 2 2

15 scale types 'wvalue' 'log'

16 scales 4 0.1 g% variables[]

17= interface '_'?-Iiuterface

18 analysis drivers 'rosenbrock' 18 analysis_drivers 'rosenbrock'
15 direct 13 direct

Figure 12: Compacting top-level sections
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5: Graphical Editors

JAGUAR'’s graphical editors are the second primary interface for creating and modifying DAKOTA
input files. A distinguishing feature of JAGUAR is that the graphical user interface for these
editors is dynamically generated from the NIDR input specification for DAKOTA. When your
locally installed version of DAKOTA is updated, you can point JAGUAR to the new version and it
will re-render to match.

Graphical-based editing is conveniently separated into “Define Problem” and “Define
Flow/Iteration” sections; see the appropriate tabs toward the bottom of the JAGUAR window
depicted in Figure 13. “Define Problem” is where the problem to iterate on is defined in terms of
models, which map variables through interfaces to responses. “Define Flow/Iteration” is where
a method or methods and possibly a strategy are specified.

19 Jsquar - DART Fooed.dak - Jaguar o)
Ede fdit Window Help

198 “Rasenbrock_Fised.dak £1

Define Problem

Source Define Problem Define FlowiTteration Execute Problern Wisualize Results

Figure 13: “Define Problem” portion of the JAGUAR graphical editor

Each pane in the graphical view has two components. On the left is the tree hierarchy, which
offers navigation across the structured input file. The right side of the view is where content is
displayed, selections made, and data entered. As an example, see Figure 14.

17



19 Jsquar - DART Foced.dk - Jagusr |
Bl fdr Window Help
198 “Rasenbrock_Fised.dak £1

Define Problem

Sections MODEL
i) There is no restriction on the number of instances

+ 4 MooeL ) Currently, there is onky Linstance.

Madel (e ) You can crasts 3¢ rary 33 you want
a o} VARIOBLES

i Irstances:

Warkables (variable
# & INTERFACE Musdel leemeneel

Intertace inteface
a i} RESPONSES
B0 Responses irespan

Source Defne Problem Define FlowiTteration Execute Problern Wisualize Results

Figure 14: Content selected from the left tree hierarchy is displayed on the right side of the view.

Top-level groups (i.e., MODEL, VARIABLES, INTERFACE, RESPONSES, STRATEGY, or METHOD),
represented by multi-colored bricks, organize active instances of each type of top-level
specification. When such a group is selected, the right pane will display an overview of the
selection. From this page, certain top-level elements will show instance restrictions for a valid
input file, allow the user to create a new instance, and to go directly to or delete an existing
instance.

Within each top-level group lie unique instances (each represented by a gray brick). An instance
contains many possible configurable settings, which are all organized according to their
hierarchy as shown in Figure 15. We call these “elements.”
=43 MODEL
=40 Modell
=gan nested

» pptional_interface_pointer
» sub_method_paointer

Figure 15: A hierarchy of possible configurable settings for MODEL.
When an instance is selected, its elements are displayed in the right content pane (see Figure
16). Note that some elements have nested elements, which are not immediately displayed in

the content pane. To view these child elements, select the element in the left hierarchy tree or
select/expand the element in the right pane.

18
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Figure 16: Display of elements from a selected strategy instance.

There are five basic types of elements in JAGUAR.

1.

Element without a value. In Figure 17, notice the checkbox to the left of the element;
this allows the user to enable and disable the element. Only enabled elements are
represented in the text input file, which can be viewed in the “Source” representation
(JAGUAR text editor). Required elements cannot be disabled.

[[]  Self-scheduling of iteratar jobs

[ output_precision

Tabulation of graphics data

Gam Details: ] Single rmethod strategy ™ -
Elernent Options =
Hyhbrid strategy 1

kAulti-start iteration strategy

m

3
Pareto set optimization strategy 3
1

Single method strategy *
] 1 b

Method painter methodl -

Figure 17: Different element types in JAGUAR.

Element with a value allows users to set values of type Integer, Real, String, or a
space-delimited list of any of these.

Nested elements supported in JAGUAR are indicated by a green bullet and the presence
of a hyperlink. Selecting a hyperlink is one way to view the nested element in the
right-side content pane.

Drop-down lists are indicated by a choice icon. When the list is selected, it behaves like
one of the former three element types. The first element of a drop-down list functions

19



as a header text to guide the user’s selection of an appropriate element below. Asterisks
also indicate the default list element.

e Some drop-down lists have categories which organize the many possible options
(See Figure 18). The left drop-down categories narrow down the keywords
presented in the right list.

e Details: Optimization: Plug-in < ®  bayes_calibration =
Element Op... o Element Options -
Optimization: Global 5 : @ bayes _calibration L
Optimization: Local, Derivative-based 14 @ dot i
undefined 4 & richardson_extrap
Parameter Studies 4 @ stanford =

Optimization: Local, Derivative-free 5 =
Menlinear Least Squares

Uncertainty Quantification ]

: Optimization: Plug-in
DACE

3
1
1
4

Figure 18 Method category drop down list and corresponding method choices

5. Pointer elements allow reference to other existing elements. Hyperlinks follow pointers
to quickly display that instance in the content pane. When an unrecognized instance
name is manually entered in a pointer element, JAGUAR automatically creates that new
instance.

The JAGUAR toolbar. Figure 19 shows (from left to right) quick access buttons for running
DAKOTA input files, displaying pretty names instead of keywords, toggling help text, displaying
comments, and toggling push-up elements (the display of one level of children in the present

right pane).
o o[
Figure 19: JAGUAR toolbar for running DAKOTA or toggling several options
DAKOTA check

@ A quick way to invoke DAKOTA to check the input deck for errors.  This is
equivalent to running ‘Check’ via the Execute Problem tab (see Chapter 6: DAKOTA
Execution).

Pretty name
L Each element in the grammar has a ‘name’ and a ‘pretty name’. The ‘name’ is

the actual text used in the input deck (formal DAKOTA keyword), whereas the pretty
name is a user-friendly description of the element.

20



algebraic_mappings = Algebraic mappings file

analysis_components = Additional identifiers for use by the analysis_drivers

Online reference

)
Each element usually has a description, often with a hyperlink to the
documentation. This is visible in the GUI on the right side when the online reference

button is selected:

strategy
o The strategy specifies the top level technique which will govern the management of iterators and madels in the solution of the
@ qy sp P 9 9 9
problem of interest. http://www.cs.sandia.gow/DAKOTA/licensing/votd/html-ref/StratCommands.html
[C] graphics (&
O tabular graphics data
i
I:! output_precision @
[F] iterator_servers Q
] iterator_self scheduling T
[] iterator_static_scheduling
o - N e
o Details: = single_method * b ;
=l Details
[¥] method pointer what i ‘ @

Figure 20: Documentation/Reference

Comments

1
o . . . .
In this following example, we see the comments in the source view:

Figure 21: Example of whole line and trailing comments in the source view

It should be noted there are 2 types of comments the above example:
1. Inline (on the same line as a keyword)
2. Before (standalone comments, multiple counts allowed)

Currently comments can be rendered and edited in the GUI (See Figure 22), but new
comments can only be added from the source view.
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method

@ A method specifies the name and controls of an iterative procedure, e.g., 2 sensitivity analysis, uncertainty quantification, or optimization method.
http:/wwnv.cs.sandigaaRakOladiccnsinatuatdbtoalarstlath 0dCommands.html

METHOD HEADER COMMENT

' method inline comment

[ id_method

[ model pointer
output

=l Details

an déﬁug i

I"-' output inline comment I

Figure 22: An in-line comment rendered in GUI

The JAGUAR GUI is simplified by pushup elements. These elements can be
displayed in the current pane instead diving deeper in the tree to see them. This helps
show the larger context in one view. Pushup elements can be collapsed by clicking on

‘Details’.  Figure 23 and Figure 24 show JAGUAR with push-up elements on (default)
and off, respectively.

interface

@ Aninterface specifies how function evaluations will be performed in order to map a set of parameters into a set of responses. http:/‘www.cs.sandia.gov/DAKOTA/

[T id_interface
] algebraic_mappings

] analysis drivers 'rosenbrock’

= Details

[7] analysis_components

[[] input_filter

[T output filter
inn Details: [® direct
o [0 failure capture

o [0 deactivate

asynchronous

[ evaluation_servers

1

B @ choose e\raluai:ion sched, * -

[#

] analysis_servers

B
ale
H

[ @ choose analysis sched, * ¥

Figure 23: JAGUAR with push-up elements enabled (default)
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interface

| (1] \35) An interface specifies how function evaluations will be performed in order to map a set of parameters into a set of responses. httpy'www.cs.sandia.gov/DAKOTA/licen

id_interface

algebraic_mappings

analysis drivers ‘rosenbrock’

nchrenous

evaluation_servers

T (| @  choose evaluation sched, * -

=] analysis_servers

i H @ choose analysis sched. * -

Figure 24: JAGUAR with push-up elements disabled

6: DAKOTA Execution

The Execute Problem tab permits executing DAKOTA in various modes on the active input file,
as shown in Figure 25. The execute options all require a locally installed dakota or

dakota.exe executable, the path to which can be set via Window -> Preferences -
Jaguar.

¥ Jaguar - DART Warkspace/Users/briadam/Documents/dakata/DART_GULtesting/pstudy.i - Jaguar EI@
Eile  Edit MWindow Help

B vectar. B pstudyi 62 =0

Execute Problem

| @ Check | Run complete DAKOTS study locally on this input..,

a Eelows run actions will autormatically save your input file

{3 Run Run DAKOTA locally on this inputfile (starting in the directory where the input lives) and display any text output / tabular graphics data,

+ Manual override

Al Pre Run Perfarm only pre-run {variables generation) phase; select methods anly

[C] Pre-run tabular output filename: pre_tun_output.dat Browse,.,

+ Manual override

Core Run

I PostRun Perform only post-run (final results) phase; select methods only

Post-run tabular input filename:  post_run_input.dat Browrse,.,

+ Manual override

[] owverride run directory: Browse...

Remote job submission

Mote: before running, you may want to set preferences forwhere DAKOTA is installed on your system

4 1

Source Define Problern Define FlowyTteration Execute Problem Wisualize Results

Figure 25: The JAGUAR “Execute Problem” tab for running DAKOTA.
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Currently four modes of DAKOTA execution are supported:

Check: While JAGUAR includes considerable input validation, the Check button uses
DAKOTA’s input parser to perform additional validation, ensuring that the study input is
ready to run. To validate the active input file (via dakota -check), select the Check
button and view the console output on the Visualize Results tab. You should see a
message indicating that the check completed and should see no errors:

Input check completed successfully (input parsed and objects instantiated).

If you observe errors, return to the editor to correct them.

Run: Selecting the Run button will execute DAKOTA on the local machine using the active
input file. Execution will take place in the same directory as the input file, so any
necessary driver scripts and data files must be present. To abort the DAKOTA run, use the
operating system’s task management features to kill the separate DAKOTA process.

Progress Information

"0" Running Dakota.. To abort, terminate the separate dakota process,

Cancel

After running, view the DAKOTA output in the console window:

<<<<< Function evaluation summary: 81 total (81 new, O duplicate)

<<<<< lIterator multidim_parameter_study completed.
<<<<< Single Method Strategy completed.

Pre Run: Pre-run is a step in the overall DAKOTA run process. For select analyzer methods
only (currently parameter studies, DACE, and sampling methods) DAKOTA supports a
pre-run mode (dakota -pre_run), which will generate the set of points at which
DAKOTA would evaluate the computational model and write them to a space-separated
tabular file. The optional checkbox Pre-run tabular output filename permits overriding
the default filename. A successful pre-run will terminate with a message:

Pre-run phase complete: variables written to tabular file pre_run_output.dat.

Post Run: After the pre-run variables file has been augmented with user-supplied
columns for function evaluation data (responses), DAKOTA can post-process it and
generate statistics, for example, to compute final statistics in a screening study. This is
the analysis counterpart complementing Pre Run. The Post Run mode permits
specification of the variables/response data file. Executing it will generate final results
output similar to Run mode:

Post-run phase initialized: variables / responses read from tabular file
post_run_input._dat.
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<<<<< Function evaluation summary: O total (0 new, O duplicate)
<<<<< Best parameters =
-2.0000000000e+000 x1

-1.0000000000e+000 x2
<<<<< Best objective function =

1.0000000000e+000
<<<<< Best data captured at function evaluation 19

For additional information on the Pre Run and Post Run modes (which are central to JAGUAR's
Sensitivity Analysis Wizard), consult the DAKOTA User’s Manual. Results from any execute
option are displayed on the Visualize Results tab as shown in Figure 26.

¥ Iaguar - DART Warkspace/sers/briadam/Documents/dakata/DART_GUT/testing/pstudy.i - laguar EI@

CLH

Eile  Edit MWindow Help
E!vector.i i,‘:!pstudy‘i b3 =l post_run_input.dat

Visualize Results
Execute output: " "Ciidakotalinstal\5.1_ext_web\Dakota\bintdakota.exe" -input "CUsershbriadariDocumentsidak ota DART_GUDtestinghpstudi® "

obj_fn
%1 -3.47498e-003
%2 -5.01178e-001

Simple Rank Correlation Matrix amaong all inputs and outputs:
x1 X2 ohj_fn
%1 100000 +000
%2 -8.08943e-002 1.00000e+000
ohj_fn -3.58401e-002 -4.96432e-001 100000 +000

Partial Rank Correlation batrix between input and output:
obj_fn
%1 -8.78362e-002
%2 -5.01205e-001

<<« << Iterator multidirn_parameter_study completed,

<« <4< Single Method Strateqy completed,

DAKOTA execution time in secands:

Total CRU = 1342 [parent=  12.42, child = 0]
Total wall clock = 12,4202

= Return to Execute Problem

Source Define Problerm Define FlowyTteration Execute Problem “Wisualize Results

Figure 26: JAGUAR Visualize Results tab showing output from DAKOTA Run mode.

For all problem execution modes under Run, a Manual override option allows modification of
the command issued to execute the dakota program. In future JAGUAR releases we hope to
support the Core Run and Remote job submission execute modes, including facilitating remote
DAKOTA job submission to a compute cluster and job status monitoring.
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7. Sensitivity Analysis Wizard

Future JAGUAR versions will include a suite of “wizards” for creating DAKOTA input files for
common analysis tasks such as optimization, parameter estimation, and uncertainty
guantification. Presently, one such wizard exists for creating a Latin hypercube sampling-based
sensitivity analysis (SA or screening) study. It creates a DAKOTA input file based on
user-specified problem characteristics and optionally allows running DAKOTA in pre-run mode
to generate a table of variable realizations. The SA Wizard also allows running DAKOTA in
post-run mode as described above to analyze user-provided tabular response data. The SA
Wizard is accessible from the Welcome screen and the menu File - New - Sensitivity
Analysis Wizard. Upon launching, select either the variables definition (pre-run) phase or
analysis (post-run) phase as shown in Figure 27.

¥ DAKOTA Sensitivity Analysis Wizard o [ 3|

DAKOTA Sensitivity Analysis Wizard

The JAGUAR Sensitivity Analysis Wizard will quide you through creating a Latin hypercube
samnpling study to assess the relative importance of variables on your computational model's outputs,

*Youwill specify the relevant wariables (pararmeters) and their bounds, number of sarmples

{model evaluations), and JAGUAR will generate a run matrix of sarnples to evaluate,

*You may either manually evaluate your model and provide the response data to DAKOTA in

tabular format, or edit the input to have DAKOTA run the model.

*Once responses are available, DAROTA can post-run to compute simple statistics and correlations on
the data, which indicate the importance of factors,

location in greferences

Start wizard frorm:

@ Step #1: Pre-run (variables generation before post-run)
Step #2: Post-run (already cormpleted pre-run earlier)

< Back Finish | Cancel |

Figure 27: The splash page for the JAGUAR Sensitivity Analysis Wizard.

Figure 28 shows the Specify Variables page of the SA wizard, where the problem characteristics
are entered. The number of samples, uncertain (uniformly-distributed) variables, and responses
must be specified. For each specified variable, lower and upper bounds are required; there are
also optional fields for specifying descriptors for each variable. Once complete, one may
generate the LHS samples in the form of a run matrix using the Generate samples option,
and/or save the input file for the LHS study using the Save input file option and specifying a

27



location for the input file. (Saving the input file at this step will end the wizard and open the
generated input file in the JAGUAR editor.)

W; DAKOTA Sensitivity Analysis Wizard (Pre-run)

= (o=
Specify Yariables
Specify the table contents
Uniform Uncertainty
MNurmber of samples 43
[ uniform uncertain variables 3
[A]  Descriptars* [os]  Distribution lower bounds* [os]  Distribution upper bounds*
‘alpha’ 0.0 10
'density’ 35.2 741
'bias' -4

-2

Mumber of response functions 4§

@ Generate samples
() Save input file:
Chllsers\briadarm\DocumentshdakotatDART_GLUDesting, Browese..,

< Back ” Text » ] Einish

Figure 28: The second (variables specification) page of the JAGUAR Sensitivity Analysis Wizard, pre-run phase.

Figure 29 shows an example of the Run Matrix (final) page of the pre-run wizard containing the
generated run matrix if the “Generate samples” option is selected. Note that this option
executes the locally-installed version of DAKOTA (in pre-run mode) to generate the run matrix.
The page also provides options for saving both the input file and the generated run matrix.
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‘,52 DAKOTA, Sensitivity Analysis Wizard (Pre-run)

Run Matrix
Result fram DAKOTA

Qutput

0.908150882 71466615
0.22167623061470165
0.34077156037450265
0.30150033770735529
0.97223801965023803
0.04517384481062852
0.87999812217407614
0.74855639295977347
0.52689296050798577

0.607126613434534

0.50912427270871607
0.90055082201806081
0.73551382145541178
0.71293879490630677
0.65810935555492085
0.007300437405632210

Save options

| Save input file

§9,412414316083627
§3,22149159622 4006
69,791624581565527
73.827913546922801
52,202891976253106
53.112427962673173
53.924905034636012
37.338622113289091
45, 763497378464336
36,042063408707525

43,190500020256358
73.023636464251538
40,744391552429451
39,443671491547754
40, 120980820169699

55.24583031054086

-2.1489913173258133
-2.7679243394885418
-3.9309327791466617
-2.5351976992475774
-2.6336855606470181
-3.8010200436402718
-3.0093594872024516
-2.1307991611619679
-3.6991578719881906
-2 A06540781175068
-3.30118079887 44315
-2.4644632720561739
-2.6801234905629654
-2.5651813295215025
-3.4561183544872112
-3.248011980324072

= |2 =]

File: | CoyllserstbriadamiDocumentsidakotatDART_G UTitestinghsawiza rd?.m|

| Save run rmatrix to file

MNOTE: add a colurnn for each response of interest to the run matrix (dat) before performing post-run,

File:  Calsers\briadamiDocumentshdakota, DART_GUDNtestinghrunmatrix.csv
raww (space-separated values) for Tecplot, Matlab, gnuplot

@ C3 (Cormma-separated values) for Excel

'i?," | < Back | et = [ Einish l | Cancel |

Figure 29: The Run Matrix (final) page of the Sensitivity Analysis Wizard, pre-run phase, with options to save the
run matrix and/or input file.

After creating a samples file (run matrix), one may add columns for response data to the file,
then return to the SA Wizard’s post-run mode. Figure 30 shows specification of the saved input
deck from pre-run and the location of the data file containing the variables and response data to
analyze. Selecting Next will run DAKOTA in post-run mode, generating any statistics or other
final results.
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3 DAKOTA Sensitivity Analysis Wizard (Post-run) [ o |2 =]
Analysis Type
Specify the pararmeters

Pararneters
Input file:

File: ChUsers\briadarmiDocurmentsydakota DART_GUDNtestinghypstudy.i

Past-run input file:

File:  Collsers\briadami\Documentsidakota\DART_GLNestingypast_run_input.dat

@ [ <Bsck |[ met> || Enh

Figure 30: Specifying the DAKOTA input file and data file for post-run mode.
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8: Generating Input Files from Templates

DAKOTA (and consequently JAGUAR) includes many example input files that users can build on,
customizing their own studies from these templates. JAGUAR 2.1 also supports User-created
templates (see Figure 31). To specify the location in which user templates are saved, go to
Window -> Preferences -> Jaguar -> Templates Path and define the template path.
Whether you want to access the standard templates library or the User-created templates to
generate a new DAKOTA input files, you can do so in two ways:

1. from the Welcome screen
2. from the main File menu (New -> DAKOTA input file from template).

After selecting a template upon which the new input file will be based, specify a location in
which to save the new input file (see Figure 32). Also, at any time, you can save an input file or
template as your own custom template with File - Save -> Save As Template (see Figure
33). By default templates are saved in the default directory specified in preferences and the
default template extension is . dak.

53 DAKOTA Templates = -2 |3

DAKOTA input file templates
Choose a template for the basis of the DAKOTA input file:

Pick a ternplate:

User-created (DARKOTA templates) -
dudd3
dude
dude?
rasenbrock
rosenbrockwhatever
Rosenbrock Fixed
sample template
testagain
Jaguar standard templates
Calibration Local Datafile Exarmple

m

Prewiew: ternplate content:

= —
'\2,.' < Back Mext = Finish Cancel

Figure 31: A list of DAKOTA input file templates available in JAGUAR.
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Save template

Selecturhere to save selected ternplate

Filer CAUsersiechan\Documentsirosenbrack.i|

® [ < Back ” Text = | [ Finish ] [ Cancel ]

Figure 32: Specifying a location for saving an input file generated from a template.

- —
Save As DAKOTA Template
1_ <« My Documents » DAKOTA tem;_rllits
Organize « MNew folder = - 0
X Favorites *  MName . Date modified Type
M Desktop || dudd3.dak 12/14/2010 2:42 PM  DAK File
| Downloads u dude.dak 12/8/2010 4:03 PM DAK File
5l Recent Places || dude2.dak 12/15/2010 4:08 PM  DAK File
u rosenbrock.dak 12/16/201012:00 ...  DAKFile
(7l Libraries || rosenbrockwhatever.dak 12/17/2010 2:22 PM DAK File
@ Documents || sample template.dak 12/8/2010 4:22 PM DAK File
o Music || testagain.dak 12/14/20101:54 PM  DAK File
[E5] Pictures
@ share
p— v 4 n 3
File name: hd
Save astype: | Dakota Template (*.dak) v]
(4 Hide Folders [ Save ] [ Cancel

Figure 33: JAGUAR Save As Template window.
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9: JAGUAR Brief Usage Tutorial

To quickly familiarize yourself with JAGUAR's basics, follow the steps here which refer to the
simple dakota input file example dakota_rosenbrock 2d. infound in the
examples/tutorial directory of a DAKOTA distribution.

Start JAGUAR.

In the Welcome screen, select “Configure Jaguar” or click Window -> Preferences -> Jaguar
(see Figure 34).

e Under JAGUAR options, provide your paths for “DAKOTA executable” (this is the full path
for the dakota or dakota.exe executable file you will use to run DAKOTA), “Save path”
(this is the full path for the directory you wish to save your input files in) and “Templates
path” (this is the full path for the directory you wish to save your own DAKOTA Templates
in).

e Select “OK”.

i - |
?‘! Preferences [ = ih]
type filter text Jaguar - - -

General
Jaguar DAKOTA executable C:\dakota\dakota.exe Browse...
Save path Ci\Usershechan'Documents Browse...

Templates path Cih\Usershechan\Documents\DAKOTA templates Browse...

V| Display pretty names by default
See comments by default
V| See help by default

/| Push up one level of child elements

Figure 34: Sample JAGUAR Preferences for tutorial.

Select File - New -> DAKOTA input file from template

Do either of the following:

1. Type “tutorial” in the quick search bar to filter the templates and select “Tutorial
Rosenbrock”.

2. Navigate down and select “Tutorial Rosenbrock”.
e A preview of the template file should be visible, as shown in Figure 35.
* Select “Next”.
¢ Specify a filename such as “rosenbrock.i”.

e Select “Finish”.
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- \
W DAKOTA Templates [ 5] ||

DAKOTA input file templates
Choose a template for the basis of the DAKOTA input file:

Pick a template:
tutorial

a ] Jaguar standard templates
Tuterial Rosenbrock

Preview template content:
#2 DAKOTA INPUT FILE - daketa_rosenbrock_2d.in -

m

strateqy,
single_method
graphics tabular_graphics_data

method,
multidim_parameter_study
partitions =8 &
model,
| single
P

Figure 35: Filtered list of DAKOTA input file templates
The input will be displayed in JAGUAR as shown in Figure 36. Try some of the following:
¢ Introduce errors into the input, notice error decorators, and mouse over them to see the
tooltip errors.
e Mouse over keywords to see additional information.

e To run the advanced parsing engine and auto-format the text, press Ctrl-Shift-F or Edit =
Format. Observe the updated rosenbrock 2d template input file depicted in Figure 37.

e You can always Undo (Ctrl-Z or Edit = ”Undo Typing”) and Redo (Ctrl-Y or Edit -
”Redo Typing”) to compare.
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E! Jaguar - DART Workspace/Users/briadam/Documents/dakota/DART_GUI/testing/rosenbrock.i - Jaguar
File Edit Window Help

single method
graphics, tabular graphics_data

oo s

2 method,

g multidim parameter study
10 partitions = 8 8

12 model,

13 =single

15 wariables,

continuous design = 2
1 lower bounds -2.0
upper kbounds 2.0
descriptors "x1'

RO

|-
o«
wow

Moo O

S

]
L Y S T R R ]

]

interface,
direct

]

analysis_driver = 'rosenbrock®

]

]

TESpONses,
num objective_functions = 1
no_gradients
no_hessians

[T
0 -]

]
[

[ S]
o oW

F [}

Source Define Problem Define Flow/Iteration Execute Problem Visualize Results

3 rosenbracki 7 =0
1 ##% DAKOTA INPUT FILE - dakota rosenbrock 2d.in -
prd

strategy,

[F=N BCR

0= Qutline &2 =g
strategy (strategy)
saw single_method
graphics

o tabular_graphics_data

method (method)

2w Multidim_parameter_study
partitions

maodel (model)

aaw single

variables [variables)

| continuous_design
lower_bounds
upper_bounds
descriptors

interface (interface)

» analysis_drivers
son direct

responses (responses)

saw Num_objective_functions

saw No_gradients

som no_hessians

Figure 36: rosenbrock_2d input file
In Figure 37 notice the following:

e cleaner look (extra spaces and newlines removed);

e analysis_driver replaced with analysis_drivers (the DAKOTA default

keyword);

e directnow asub-element of analysis_drivers (ordered according to the

DKAOTA input specification syntax); and

e double quoted “x2” replaced with single quoted 'x2’ (uniformity).
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- strateqgy

single_method

graphics

tabular graphics data
~ method

multidim parameter study
8 partitions 8 8

[FUR ]

[a4]

< model

10 single

11=wariables

12 continuous design 2

13 lower bounds -2 -2

14 upper bounds 2 2
15 descriptors '
1e= interface

17 analysis drivers 'rosenbrock’
direct

x1l' '=m2"

- responses
num objective functions 1
no_gradients
no_hessians

=]

R3 ORI ORI RS}

[

Figure 37: “Updated” rosenbrock_2d template input file after using the format option

To execute DAKOTA to perform this two-dimensional parameter study, select the tab “(3)
Execute Problem” at the bottom (see previously in Figure 25). Click “Check”. Notice the
following output (for reference see Figure 26):

e actual DAKOTA command (in green) that just ran, followed by.
e output of DAKOTA’s check mode.

Now go back to the Source (1st tab):

e Find tabular_graphics_data (around line 5), create a new line below and press Ctrl-Space.
Notice a list of potential keywords are listed in a dropdown, see Figure 38.

e Press up or down arrows to navigate.

¢ Navigate to “output_precision” but DO NOT press Enter.

2= strategy
3 single_method
4 graphics
= tabular graphics_data
&
80 metH .A-! tabular_graphics_file - tabular graphics_data “::zﬁ?gx;gmphfrs_dafa
g L] output_precision tabular_graphics_file: String
L |1 | iterator_servers
11 model iterator_self_scheduling http:/fwww.cs.sandia.gov/daketa/licensing/votd/html-ref/StratC
12 iterator_static_scheduling Mo subelements
3% vari| (@ method
14 @ variables
L5 Lﬁ interface
3
. Lﬁ responses
LE= inte|

Figure 38: Ctrl-Space Auto-completing keywords in the text editor.
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¢ Notice that strategy is highlighted in the text, and also listed next to output_precision.
Auto-completing keywords are reverse sorted, so that keywords at the top are the closest
context-matching keywords. This helps you discover relevant keywords.

e Select output_precision by double clicking.

¢ Notice auto-complete types in an equal “=" for you to remind you to enter a value and a
yellow triangle with exclamation appears indicating missing data.

e Type in “notinteger” for the value of output_precision. A red circle with X and red
underline appear to indicate an error. Mouse over it (as in Figure 39) to see the reason
for the error.

B e output precision = notintegﬁx

Error: Detected an invalid keyword "notinteger”
10= method

malridim naramearer arundun

Figure 39: Text error detailed message.
e Correct by replacing it with a valid integer, such as 9, and notice error marker disappears.
e Onthe next line, type in “iterato”, then right after the “0” in “iterato”, press Ctrl-Space.

¢ Notice auto-completion can also finish off half-completed keywords. Pick one (see Figure

a8 7 itexata
8 = strategy
o 1] iterator_servers - strategy iter:tgn): SErVErs: Integer
o nethod iterator_self_scheduling -
11 multidi iterator _static_scheduling http://www.cs.sandia.gov/dakota/licensing/votd/htmi-ref/StratCq
o method
12 par] '*la‘ Mo subelements
13- model 4% variables
4 single Lﬂ interface
5= variables &% responses

6 continyg
T 1ow
18 upp|
13 des|
20% interface

21 analysil

R E P

Figure 40: Text editor auto-completion of partial words.
Save this edited rosenbrock file as your own template (see Figure 33): File = Save As Template

¢ Notice: the default save location is that specified earlier in the Jaguar Preferences.
e Name it “Rosenbrock Fixed”.
e Click “Save”.

Close all files (Ctrl-Shift-W) or File - ”Close All”. No need to save changes.

Click on File - New -> DAKOTA input file from template. Notice that both JAGUAR and
User-created templates are available.
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e Do either of the following:
1. Type “Fixed” in the quick search bar and select “Rosenbrock Fixed”.

2. Navigate down and select “Rosenbrock Fixed”.

r - .
3 DAKOTA Templates - (S

DAKOTA input file templates
Choose a template for the basis of the DAKOTA input file:

Pick a template:
type filter text
4 DAKOTA templates -
dudd3
dude
dude2
rosenbrock

m

rosenbrockwhatever
Rosenbrock Fixed
sample template
testagain
4 [ Jaguar standard templates
Calibration Local Datafile Example 2
Preview template content:
£2 DAKOTAINPUT FILE - dakota_rosenbrock_2d.in -
strateqy
single_method
graphics
tabular_graphics_data
method
multidim_parameter_study
partitions 8 8
model
single
variables
continuous_design 2
lower_bounds -2 -2

m

Fv
@ < Back Next » Eridr

Figure 41: Rosenbrock Fixed DAKOTA Template.

¢ Notice in Figure 41 that:

1. This time we are creating an input file from a user-created template.

2. User-created templates do not have stars on them and are listed at the top.
e A preview of the template file should be visible.
e Select “Next”.
e Specify a filename such as “rosenbrock_fixed.i”.
e Select “Finish”.

This completes the basic tutorial showing a few features of JAGUAR 2.1.
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10: Troubleshooting

In case of unresolvable errors, review the current JAGUAR FAQ linked from the download page
and the DAKOTA web pages. The most common troubleshooting options are excerpted here for
convenience:

1. Check for sufficient Java version: In a terminal or Command Prompt type “java -version”.
You should have at least Java 1.5.

2. |If there exists a corrupted JAGUAR workspace, remove the workspace (User_folder >
Jaguar_workspace).

3. If some window views are missing or if they are incorrectly positioned, restore the
default view by selecting: Window—>Reset Window Layout

4. Enable Error Log: Window -> Show View -> Error Log (see Figure 42). This view will
provide detailed logging of anything that went wrong inside JAGUAR.

File Edit | Window | Help
B “Rocen New Window
Defi Mew Editor
SiliE Show Toolbar
Section Show View »| Bl Console Alt+Shift+Q, €
type fil ()
YpeT Reset Window Layout ¥ ] Errorlog Alt+Shift+Q, L
& 5 Outline Alt+Shift+Q, 0
HEEEES Ei Problems Alt+Shift+Q, X
|g VARIABLES
Variables (variables) Other... Alt+Shift+Q, Q
P —

Figure 42: Enabling JAGUAR Error Log.

Send any errors listed to our support email jaguar-help@sandia.gov.
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Distribution

1 MS0899 Technical Library 9536 (electronic copy)
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